Bab 4 Membuat Peta Sederhana dan Layout

Menyiapkan Map Proyect baru

Mulai ArcMap dan pilih New Maps = My Templates = Blank Map
9 norowaren e

Choose a template for your new map

E]- New Maps My Templates

My Templates.
1
O

Blank Map

i Browse for mare..,

I mm | ;

= :‘JJsers‘Patid(\ApDData\Roamiﬁg\ESRl \Desktop 10, 0%ArcMap Templates Mormal. mxt

Default geodatabase for this map: What is this?

- &
o[ o]

Sistem Koordinat pada Map Proyek (mxd)

Melakukan pengaturan sistem koordinat pada saat memulai pembuatan map proyek adalah kebiasaan
yang bijak. Penentuan sistem koordinat ini sangat penting sekali ditentukan di awal pembuatan project.
Kita akan menentukan Geographic Coordinate System Datum WGS 1984 (GCS 1984) sebagai Sistem
Koordinat pada Map Project Kita.

Sistem koordinat data frame dan sistem koordinat data bisa berbeda. ArcMap dapat melakukan on-the-
fly projection, yakni menampilkan data yang memiliki sistem koordinat berbeda dengan data frame.

Mengatur Proyeksi Data Frame

Di TOC klik kanan di atas data frame (Layers) dan pilih Properties...
Pilih Tab Coordinate System
Cari dan pilih Geographic Coordinate System (GCS) WGS 1984 yang terletak pada
o Predifined 2 Geographic Coordinate System = World 2> WGS 1984
Agar memudahkan pencarian di lain waktu, saat WGS 1984 terpilih, Klik pada Add To Favorites agar
sistem koordinat ybs langsung berada di bawah Favorite.
Klik OK
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g Tools Current coordinate system: ‘ G
FEY LIS
m Jaca peto.. —_— Datum: D_WGS_1984 s
%7 New Group Layer
& New Basemap Layer
B Copy
X Remove 3
< » Transformations...
Select a coordinate system:
iy ITRF 1994 - Modify...
ITRF 1996
' b |
ollapse All Layers i ITRF 2000 Impor .
Reference Scale > 3 ;r;;czgg?z
Advanced Drawing Option WS 1968
Labeling » ) WGS 1972 e Add To Favorites
- 364 Remove From Favorites
® Proj Coordinate Systems L
-3 <custom> -
Activate P u o<y »
: Drawing [*f* Properties... [ OK ][ Cancel ][ Apply ]
Display the it
Menambah data

ArcMap mendukung banyak sekali format data GIS baik yang berupa data vektor, raster, maupun tabel.

e Untuk Menambahkan data ke dalam suatu Map Project bisa mengunakan Catalog Window
e DiStandard Toolbar Klik Windows Catalog untuk buka Catalog Window

& - | 1589.429514 - L{'ﬁlﬁlﬂ'ﬁﬁ

e Di Catalog Window anda bisa browse Folder-folder di Komputer anda seperti di Windows Explorer akan
tetapi hanya tampil data yang bisa digunakan di dalam ArcGIS. Selain itu anda bisa browse Database
Connections dll.
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b - | 1589429514 - EEERE P L :
Catalog ' B
-2 et @E-le &
Location: £ C:\ArcGIS10_Dasar\CourseData ¥ :cng_J

& [ Home - ArcGIS10_Dasar\MXDMapProjects -
= EX Folder Connections
E 8 A
Bl £ CA\AreGIS10_Dasar\CourseData
= = Datalatihan
[ £ Bab03_PengenalanircGIS
[E) a_NTB_Kabupaten.shp
[E) a_ntb_tutupanlahan.shp
[ a_world_Country1999.shp
[E) a_world_provinces2008 shp u
& B Hillshade SRTM_50_14_NTB_UT?
& @ 172116066_06620000819_B123457
= I_world_rivers.shp
I__,_] p_world_cities.shp
& B SRTM B0_14_NTB_UTMS0S.tif
# £ Babh04_MembuatPetaSederhana
[ [ Bab05_AttributdanSimbologi
# £ Bab0&_SisternKoordinat
# £ Bab07a_XYData

m

e Kita akan menambah satu Folder Connections shortcut kepada data Latihan Kursus ini.

e Di Catalog Window klik tombol Connect to Folder i) browse ke dan pilih folder
c¢:\ArcGIS10 Dasar\CourseData (atautempatdi mana anda telah copy data latihan) dan klik OK

e Folder Connection Baru ke Folder CourseData akan muncul di Catalog
X

Cr> ol @ EaE

Location: &£ C:\ArcGIS10_Dasar\CourseDal +

# E5] Home - ArcGIS10_Dasar\MXDMapP =

IF =5 Folder Connections

= &5 G\

=R C:\ArcGIS10_Dasar\CourseData
£ Datalatihan

Choose the folder to which you want to connect:

4 £ Local Disk (C2)

[m] »

| _FS_SWRINFO

. MXDMapProjects

. MyExcercises -
Folder: C:\ArcGIS10_Dasar\CourseData = E Grafik
# B MXDMapProjects
[ Make New Folder I [ OK ] [ Cancel ] i
# B MyExcercises

e Browse ke Folder Bab04 MembuatPetaSederhana dan lihat bahwa terdapat 4 shapefile

=l B3 Datalatihan

# [ Bab03_PengenalanArcGIS

= [ Babl4 MembuatPetaSederhana
&= a_world_Country1999.shp
IEl a_world_provinces2008.shp
=] I_world_rivers.shp
(%] p_werld_cities.shp

e Dari Simbol-simbol kita dapat langsung membedakan fitur shapefile seperti berikut: Titik/Point Q,

Line/Garile] dan Polygone@.
e Drag and Drop (Tarik) Shapefile a_world_Countru1999, | world_rivers dan p_world_cities ke dalam

Data Window.
e Data muncul di TOC and di Layard dan ArcMap membuat link ke shapefile (datafile).
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e Klik File = Save As ... untuk menyimpan MapProject di Folder CourseData\MyExercices dengan
memberi nama yang jelas.

Qs v e S s

File | Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help

O New. Ctrl+N b;. 1321282325 S-S L= R
‘ = =
- e OSMM-!‘%
Save — b
Savein: |, MyExcercises v 6 J = '] @ ]
Save A Copy... @= Name : Date modified Type H
Add Data "‘) @] Bab04_Petalndonesia_Patrick 03/11/201218:15 ArcGIS An
Recent Places
B4 Ssignin...
-
BE ArcGIS Online... -
Page and Print Setu, Desktop
EQ Print Preview... =
& Print... 495
Librari
&2 Create Map Packag LR

Export Map... &f

Map Document Pro Computer

1 F:\Ser...\Bab03-1_ )
2 ..\Bab05-1_Siste ' i

Strcec- ok I 2 Bab04 Petalndonesia_Patrick

4 F:\Ser...\Bab03-1_
5 F:\ServerP...\Peta_ | reMap Document

6 ..\KM_StreetAtlas_Indexpage.m...

R

A SNVY U Ve DU i e

e Perhatikan bahwa ArcMap Document-file (dengan extensi *.mxd) hanya menyimpan cara menampilkan
data, urutan layer-layer, dan layout tetapi bukan datanya. Data tetap di shapefile dan hanya di LINK ke
dalam ArcMap Project.
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Mengubah Nama/Rename Layer

Mengganti nama layer sangat disarankan untuk dilakukan agar peta lebih rapi. ArcMap secara default
akan memberi nama sesuai dengan nama data tanpa memperhatikan kaidah penulisan, misalnya
besar/kecil hurup. Penggantian nama layer tidak akan mengganti nama data.

Klik pada Layer yang akan diganti nama, misalnya layer ‘I_world_rivers’

Tunggu beberapa detik, klik lagi pada layer terpilih tersebut.

Status editing akan muncul, ketik nama ‘Sungai’

= 1 T e o [ EEEETE | = o o

Ganti Nama layer lain pada Kota Besar dan Negara

Merubah Symbology

Symbology berkaitan degan bagaimana mempresentasikan data di peta agar pengguna mendapatkan
informasi secara efektif. Symbology adalah salah satu bagian penting dalam pembuatan peta di ArcMap.

Kemampuan kita sebagai kartografer sangat diperlukan.
Perlu ditegaskan bahwa dalam pengaturan symbology tidak ada benar /salah. Pentingnya, informasi

yang pembuat peta bisa dimengerti dengan mudah oleh penguna.
Pengaturan symbology di bagian ini hanya membahas yang sederhana saja. Pengaturan symbology yang

lebih kompleks dibahas pada bab lain di buku ini.

Symbology Point Sederhana

Pengaturan symbology point yang sederhana adalah dengan mengatur symbology sama untuk semua
point.

Cara mengatur symbology yang cepat adalah dengan meng-Klik symbol yang ada di TOC. Untuk
mengganti symbology Kota, Klik di atas simbol point di bawah nama Kota

ia Patri - =
@ Bab04_Petaindonesia Patrick - ArcMap - Arcnfo__ -_ = | B |l

File Edit View Bookmarks Insert Selection Geoprocessing Customize  Windows Help

DgEs b - | 1:39.256.198 Y EEEEE R 2 ;
Table Of Contents AN e T 7 = [;]
8ec8 4 < - : B |o

= = layers Eﬂ i K a e 35 XY §

= 3 Besar
®

= M Sungai

¥ B

= Megara
=

Akan muncul Window Symbol Selector di mana anda bisa pilih Marker Symbol dan mengatur Warna,

rotasi serta ukurannya.
Pilih Kotak dan ganti warna pada medium coral light dan ukuran 9.
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sprasioer T, e
Type here to search @ @ a5~ Current Symbal
Search: @) All Styles () Referenced Styles
B
ESRI 3
L _ A g
Cirde 1 Square 1 Triangle 1
Color: n"
e o o =
Pentagon 1 Hexagon 1 Octagon 1 Angle: 0,40
® ® & Edit Symbol...
Rnd Square 1 Circe 2 Square 2
& @ @
Triangle 2 Pentagon 2 Hexagon 2
Style References...
O © @ Ao ] [ e

e Semua Fitur di Layer Kota Besar sekarang digambar dengan symbol kotak, merahan ukuran 9.
e Untuk Fitur bentuk Garis anda dapat mengatur Warna dan width (tebalnya) garis dan untuk polygone
anda bisa mengatur Warna Isi, Outline Width (Tebalnya Garis Keliling) dan Outline Color (Warna Garis

Keliling).
i N i <
Type here to search - @ @ 88~ Current Symbol Type here to search - @ @ 88~ Current Symbal
Search: @) All Styles () Referenced Styles Search: @) All Styles () Referenced Styles
ESRI & ESRI -
- - = .
Highway  HighwayRamp  Expressway 1 o @ Seen B Sun A s oo
— = D D D 5| outewan o0 [
Holl Lake R i
Expressway  MajorRoad  Arterial Street Edit Symbal... S . i Outiine Color:
Ramp =
Edit Symbol...
Collector Street  Residential Railroad . s i -
Street
i I l:‘ |:| D
: Green Jade Blug
River Boundary, Boundary,
National State
Style References... |:| |:| D Style References...
- - B - oK Cancel - oK Cancel

Symbology Point Berdasar Kategori

Berdasarkan data attribut, data ‘Kota Besar’ memiliki informasi mengenai apakah kota berupa Ibukota negara
atau bukan (attribute field “kelas”). Di ArcMap, kita bisa membuat symbology yang berbeda-beda untuk Ibukota

negara dan kota biasa mengunakan data atribut itu.

e Cara symbology berdasarkan kategori Klik kanan di atas layer Kota Besar dan pilih Properties...

e Pilih Tab Symbology

e Pilih Show: Categories: Unique Values
e Pilih Value Field: kelas dan Klik Add All values
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| General | Source | Selection | Display| Symbology | Fields | Definition Query | Labels | Joins & Relates | Time | HTML Popup |
Show:
o ' of one field. import...
Value Field CEHER i
kelas - | [ B | R
P Symbol  Value Label Count
Charts D + | <all other values: <all other values> 0
Multiple Attributes <Heading> kelas 561
® e Ibukota 115 .
@ | Kota biasa Kota biasa 446 i
Add All Values ||| Add Values... | [ Remove || Removel | |
ok J[ Concsl J[ soot |

e Gambar di atas menunjukan bahwa terdapat dua kategori kota, yaitu Ibukota dan Bukan Ibukota.
Selanjutnya kita akan mengganti masing-masing kategori dengan simbol berbeda.

e Double Klik di atas simbol Ibukota. Buat simbol @ Cirlcle 7, warna medium coral light, size 13.

e Double Klik di atas simbol kedua (yang tidak ibukota). Buat simbol © Cirlcle 2, warna medium coral

light, size 9.

e Gambar di atas masih memiliki parameter-parameter yang tidak perlu. Set Symbology agar tidak
menampilkan ‘All other values’ dengan cara mematikan tanda centang di sebelahnya.

e Edit Label (masih di dalam tab Symbology). Heading “Kelas” ganti menjadi “Status”, Nilai “Kota biasa’

4

kita ganti menjadi ‘Kota Lain’, nilai Ibukota kita ganti menjadi ‘Ibu Kota'.

e Jika di OK, tampilan di ArcMap kira-kira seperti berikut

(@ B2b04_Petalndonesia_Patrick - ArcMap - Arcln (== %
File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows  Help
HE % |0 | &+ | 130000000 ] EEEEE & B R . i

I x

5 o R

Status
@ Ibu kota
@ Kotalain
=] Sungai %

= MNegara
]

Goielen &l

;
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Symbology Garis Sederhana

e layer ‘Sungai’ adalah layer bertipe garis (polyline). Untuk latihan sekarang, kita akan melakukan editing

symbology sungai secara sederhana dengan cara sebagai berikut:
o Kilik di atas simbol sungai di bawah nama layer ‘Sungai’

o Pilih Color menjadi biru (silakan tentukan saja model biru yang mana) atau pilih Preset River

o Tentukan Width menjadi 1,5

e Jika sudah klik OK

Type here to search | @ ,a EE »  Current Symbol
Search: @) All Styles () Referenced Styles
-
Expressway Major Road  Arterial Street T
Ramp =
= Color:
= = S width: 1,5 =]
Collector Street  Residential Railroad
Siymet Edit Symbol. ..
River Boundary, Boundary,
Mational State
e pu— S——
Boundary, Boundary, City  Boundary,
County Military I...
R e — a——u [ Style References. .. ]
Bruindzry Brundzary Ereswzu T [ £ ] [ Cancel ]

Symbology Polygon berdasarkan Kategori

e Supaya Negara Indonesia ditampilkan dengan warna berbeda dibandingkan Negara Lainnya kita juga

menguanakan symbology berdasar category.
e Buka Layer Properties pada layer Negara dan pilih Tab Symbology.

e Pilih Show:Categories:Unique Values
e Pilih CNTRY_NAME di Values Field

e Klik tombol Add Values...

e Klik Complete List, scroll dan pilih Indonesia dan klik Add to List.

e Ganti Symbol untuk Indonesia pada warna merah muda dan Symbol untuk All other values pada abu-

abu muda.
|Genem| I Source ISeledlon I D|5p|ay| Symbology | Fields I Definition Guery I Labels I Joing &Relatal Time: I Add Values ‘ @g
Show: ]
!Drau using unique values of one field. Import
Features i ) [
i ‘u’alue Field Color Ramp o
: - -
-+ Unigue values CNTRY_NAME - | 0l p CIay =—
Y
i.. Match to symbols in 3
CQuantities Symbol  Value Label Count
Charts «all other values> «all other valuess
Muitiple Attributes <Heading> CNTRY_NAME Ireland
I:llndonesia Indonesia 2
+ lele of Man -
] +| I Complete List I
New Value
Letz you add a value to the list above.
Add to List I
[ Add Al Values [ Add Values. .. Remove Remove All ] [ Advanced ']

Tutorial Arcgis10 Tingkat Dasar

GIZ-DeCGG | Bappeda Province NTB



e Feature Polygon Indonesia ditampilkan dengan warna merah mudah dan semua polygone lain (all
other values) ditampil dengan abu-abu muda.

2 = layers
=] p_world_cities
Status
@ Ibu kota 4
@ Kota lain
=] Sungai

= = =
[] =all other values>
CNTRY_NAME
[JIndonesia

Mengatur Label

e Label memiliki peranan yang sama pentingnya dengan symbology dalam hal pembuatan peta di
ArcMap. Latihan pemberian label di bab ini hanya yang sederhana saja. Pengaturan label lebih
lanjut dibahas pada Bab selanjutnya.

e Untuk memberi label pada layer Kota Besar puka Layer Properties pada layer Kota Besar dan pilih
Tab Labels

e Centang Label features in this layer

e Pilih Method : Label all the features the same way

e Pilih label field : NAME (menentukan field di table attribute yang digunakan untuk label)

e Tentukan warna tekt hitam, tipe font Arial, ukuran font 8

——
| General I Sounce I Selection I Display I Symbalogy I Fields I Definition Queq.fl Labels |IJo'Lr15 & Helatesl Time I HTML F‘opup|
| Label features in this layer I
Method: [Label all the features the same way. V]
All features will be labeled using the options specified.
Tent String
Text Symbol
@] Adal -3 -
ABc
B 1D
Diher Options Fredelined Label tyle
Placement Properties... ] [ Scale Range... ] [ Label Styles... ]
[ ok [ cone || Appiy

e Klik OK untuk konfirmasi
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e Memberi Label pada Layer Negara dengan cara yang sama mengunakan attribute CNTRY_NAME pada
label text.

e Untuk mencegah ada label untuk masing masing feature part (misalnya pulau) buka Dialog Placement
Properties dan pilih RemoveDuplicated Labels

M;_{_W"A"J""" |

Placement |Conﬂjd Deted.ion|
Palygon Settings

Layer Properties

| General I Source I Selection I Display I Symbology I Fields I Definition Query| Labels | Joins & Relatesl Tim

Label features in this layer

Method: [Label all the features the same way. ']

@ Always horizontal
All features will be labeled using the options specified.

() Always straight

Text String ) - (7 Try horizontal first, then straight
Label Field: CNTRY_NAME it
Text Symbal = [ Only place label inside polygon

i?] Anial -~ 10 -

ABc
By
Pre-defined Label Style

[ Placement Propeties... ] [ Scale Range... ] [ Label Styles...

Duplicate Labels
(@ Remove duplicate labels

(©) Place one label per feature

(7 Place one label per feature part

ok | [ Cancel |[ Aoy |

e Peta Kita kelihatan sudah bagus. Sekarang kita siap untuk membuat Map Layout.
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Sekilas Kartografi

Peta adalah gambaran sebagian atau seluruh muka bumi baik yang terletak di atas maupun di bawah

permukaan dan disajikan pada bidang datar pada skala dan proyeksi tertentu (secara matematis).
Karena dibatasi oleh skala dan proyeksi maka peta tidak akan pernah selengkap dan sedetail aslinya
(bumi), karena itu diperlukan penyederhanaan dan pemilihan unsur yang akan ditampilkan pada peta.

Kartografi adalah ilmu dan teknik pembuatan peta, dimana ini merupakan satu seni, ilmu pengetahuan,

dan teknologi pembuatan peta. Sedangkan Peta merupakan gambaran wilayah geografis, biasanya
bagian permukaan bumi. Ada beberapa persyaratan yang harus dipenuhi dalam membuat peta yang

baik, antara lain:

Peta harus memberikan gambaran yang mendekati kondisi sebenarnya. Ini berarti peta tersebut

o Petatidak boleh membingungkan
o Peta harus dapat dimengerti dan ditangkap dengan oleh pembaca/pengguna peta (informatif)
O
harus cukup teliti sesuai dengan tujuannya (representatif)
O

Karena Peta tersebut dinilai melalui visual (indera penglihatan) maka peta harus dibuat dengan

tampilan yang sedap dipandang artinya harus menarik, rapi, dan bersih (interaktif)

Penyusunan data, Layer, Symbology, Label dll. Map Layout juga sangat penting. Agar peta yang dibuat

memenuhi persyaratan tersebut, maka beberapa komponen peta yang sebaiknya ada dalam sebuah

peta dalam membuat Layout antara lain:
- lIsi Peta/ Data Frame
- Judul Peta
- Penunjuk Arah
- Skala Peta
- Legenda/Keterangan
- Grid Koordinat
- Penjelasan Sistem Projeksi
- Penjelasan Sumber Data
- Peta Situasi
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Untuk membuat Map Layout kita harus ganti dari Data View ke Layout View

e Pindahkan ke Layout View dengan klik Menu View = Layout View. Atau klik ikon di bagian bawah
halaman data.
@ B2b04_Petalndonesia_Patrick - ArcMap - Arcln

Eile

Edit

Oz2@

Table Of Cor*

%8 &

View l Bookmarks Insert Selec

Data View

|

Layout View
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Graphs
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Scroll Bars
Status Bar
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Setelah mengganti ke Layout View, maka peta akan disajikan pada halaman layout.Selain di Data View di

Layout View anda bisa lihat Kertas, border kertas dIl. Dan bisa lihat posisi element element di kertas.

R ol 1 )

@ Bab04_Petalndonesia_Pa

File Edit View

BECERE LRI

Table Of Contents 1 x
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Bookmarks Insert Selection Geoprocessing Customize Windows Help
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e Untuk Navigasi di Halaman/Kertas ArcMap menyediakan Tools di Layout Toolbar.

@@ﬂ@l@@l 50~ | B B

100

e layout toolbar memuat tools yang dipakai untuk navigasi halaman layout. Tools tersebut antara lain
zoom in, zoom out, pan dan beberapa tools lain.

Icon

3

=
&2

I
&

Name Tool

Zoomin/
Zoom out

Pan / Geser

Zoom Whole
Page

Zoom 100%

Fixed zoom in /
zoom out

Fungsi

Memperbesar atau memperkecil peta pada layer yang aktif di halaman
layout.

Menggerakkan halaman/kertas layout.

Menampilkan seluruh halaman layout di monitor.

Menampilkan halaman layout dengan skala 1:1 di monitor.

Memperbesar atau memperkecil halaman layout dengan 125% /80%.
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& P Go to next / Ke tampilan halaman layout sebelum atau sesudah.
= (=
previous extent

RO% « | Zoom control | Menampilkan halaman dengan ukuran perbesaran yang diinginkan
pengguna. 100% adalah ukuran di print sama dengan ukuran tampilan

di monitor.
=] Toggle Draft Digunakan untuk membuat layout tanpa tampilan peta, sehingga
mode pengguna tidak perlu menunggu gambaran peta. Pada toggle draft

mode, peta diwakili dengan judul layer.

Focus data Untuk fokus pada data frame yang aktif.
frame
i Change layout | Untuk mengubah layout. Pengguna dapat memilih template peta yang
diinginkan.
I@ Data Driven Untuk membuat Dadat Driven page — satu data frame digunakan untuk

Page Toolbar beberapa peta, contohnya untuk membuat Atlas atau map series yang
berdiri dari berberapa halaman yang bersangkutan.

e Perlu dicatat bahwa setiap project di ArcGIS hanya dapat menyajikan hanya satu layout.

Mengatur Halaman Layout
Adalah suatu tindakan yang baik dan rapi jika pengaturan di layout selau dimulai dengan Page and Print
Setup.

e Klik di menu File = Page and Print Setup
e Tentukan printer yang akan digunakan. Tergantung kepada printer yang terpasang di komputer anda.
e Tentukan size, source dan orientasi kertas. Untuk latihan ini kita gunakan ukuran kertas A4, Orientasi
Landscape.
e Tentukan Map Page Size. Untuk kepentingan praktis, biarkan Layout kita sama persis dengan ukuran
kertas printer.
e (atatan:
o Untuk membuat layout dalam ukuran kertas A4 (menjadi A3, A2, A1, dan AOQ, dst) maka jenis
printer harus disesuaikan dengan Jenis Plotter.
Printer biasa (seperti Deskjet) biasanya maksimum hanya untuk ukuran kertas A4
Untuk membuat layout peta yang lebih besar daripada ukuran maksimal yg ditentukan oleh
printer atau kalau peta hanya akan diekspor secara dijital, menonaktifkan “Use Printer Page
Settings” di Map Page Size Section dan tentukan ukuran peta yang anda ingin.
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Printer Setup

MName: -‘g EPSOMN TX121 Series - Properties...

Status: Offline

Type: EPSOM TX121 Series

Where: UsBoo2

Comments:
Paper
Size: A4 210 % 297 mm - [ Printer paper
Source: _S.He_et - Printer Margins
Orientation: (7 Portrait (@ Landscape I:l Map Page (Page Layout)

Sample Map Elements
Map Page Size

Use Printer Paper Settings

Page

Page Size that will be used is equal to Printer Paper Size

Width: 8,27 . Inches -
Height: 11,69 Inches -
Orientation: Portrait (@) Landscape

Show Printer Margins on Layout [ | Scale Map Elements proportionally to changes in Page Size

o) (o

Isi Peta

e [si peta menunjukan isi dan makna ide penyusun peta yang akan disampaikan kepada pengguna peta. Isi

peta ini sangat tergantung pada tujuan dari peta tersebut dibuat. Secara teknis, pilihlah layer — layer
peta yang terkait dengan tujuan peta, kemudian susunlah layer — layer peta tersebut dengan benar.
e [si peta tadi sudah dibuat dengan data frame di data View.
e  Atur agar Data Frame dapat pas dengan ukuran kertas dengan cara menggeser Control Box dengan
menggunakan tool Select Element R dari Tools Toolbar.
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Judul Peta
Judul peta harus mencerminkan isi peta, yang perlu diperhatikan dalam pemberian Judul Peta harus
padat dan mudah dimengerti. Pada kolom judul, secara terpisah sebaiknya ditambahkan informasi
tempat dan waktu, sebagai contoh:
“Peta Penunjukan Kawasan Hutan dan Perairan
Provinsi Nusa Tenggara Barat
Tahun 2012”
e Klik menu Insert > Title.

Selection

=i Data Frame

I Ite  Title

Text

Geopr

Dynamic Text 3

[ Meatline...
*
N

e Tulis judul yang mewakili peta pada kotak Insert Title. Judul akan diinsert di suatu tempat dalam
halaman. Untuk mengubah bentuk dan ukuran judul sesuai kebutuhan, klik kanan pada kotak judul dan
pilih Properties. Setelah itu akan muncul kotak Properties. Ketiklah judul pada kolom text yang telah
disediakan.

Inzert Title i ﬁ

What tile would you like to give your map?
Peta Administrasi Indonesia 2012

[ oK ][ Cancel ]

|

e Mulai dengan ArcMap 10, Title/Judul adalah Dynamic Text, artinya, kalau anda mengganti Title Peta di
Document Properties, Judul di Petaakan ganti secara otomatis juga.
<dyn type="document" property="title"/>

e Untuk berubah font dan style judulnya Klik “Change Symbol”maka selanjutnya muncul windows Symbol
Selector. Mengatur tampilan style sesuai dangan keinginan.
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g M i s T e
Type here to searc - Current Symbol
Text | Size and Position -
Search: (@) All Styles
Tet: nistrasi Indon
<dyn type="document” property="title" /= - Country 1
AaBbYyZz ‘
Color:
Country 2 i [E]
@) Arial -
- AaBbYyZz Sz 16 -
Fort:  Adal 16,00 = = = S Style: I U s
Angle: fH}D : Character Spacing: ﬁi}l} AaBbYyZz
o o0
. AsBEYYZz
About Formatting Text ] L Change Symbol... ; !
County Style References...
[ ok ][ Ganel ]| fopty | o - o) [cme

Sumber Peta dan text lainnya
e Biasanya sebuah peta merupakan kumpulan dari beberapa informasi spasial yang disajikan dalam
lembaran peta. Informasi — informasi yang digunakan biasanya berasal dari beberapa sumber. Untuk
meyakinkan kepada pengguna peta maka harus dijelaskan secara singkat sumber peta tersebut.
Biasanya sumber peta meliputi: nama peta, tahun pembuatan, lembaga pembuat, tahun dibuat dan
skala peta.
e Klik Menu Insert > Text.

Insert | Selection Geopr

= DataFrame
Ttie  Title [
A Text

Dynamic Text  »

[] MNeatline...

i= Legend..

% MNorth Arrow...
E=  Scale Bar...
N Scale Text...
|Z| Picture...

[ Object..

e Kemudian akan muncul kotak teks pada halaman layout. Klik kanan pada kotak teks tersebut, pilih
Properties. Akan muncul kotak dialog Properties.

e Tulis teks untuk ditampilkan pada layout peta. Untuk mengatur jenis tulisan klik Change Symbol, maka
selanjutnya akan muncul kotak dialog Symbol Selector.
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Text | Size and Position

Ted:
Sumber Data: ESRI Data 2008 -

Dibuat aleh: GIZ / P. Oswald (2012)

1

Font:  Anal 10,00

Angle: Dﬂ;ﬂ .:"i. Character Spacing: DDD
Leading: 1}1}[!
About Formatting Text ] [ Change Symbal... ]

Penunjuk Arah / Arah Mata Angin
e Simbol arah dicantumkan dengan tujuan menandakan orientasi peta. Arah Utara biasanya mengarah ke
bagian atas peta. Kemudian berbagai tata letak tulisan mengikuti arah tadi, sehingga peta nyaman
dibaca dengan tidak membolak-balik peta.
o Klik Insert > North Arrow.
e Selanjutnya kotak dialog North Arrow Selector akan muncul. Panah penunjuk arah dapat diedit dengan
mengklik tombol Properties.

Insert | Selection Geopi AT TET S SE |
E Preview

=¢ Data Frame 1 N N “ N
it Title I ﬁL L A
A Ted ESRINoth1  ESRINoth 2

Dynamic Text 3 A N
[] Neatline... " ¢ ¥ i . ...\.S
o s N
i=— Legend... ESRINoth4  ESRINoth5  ESRINoth 6
n  Morth Arrow... y

Scale to fit page

‘== Scale Bar... . = bl
; " [ Properties ]
10 Scale Text. ESRI North 7 ESRINoth®  ESRINothS [ = 3
B Ficture.. P e——
@ Object... <[ ok ][ cance |

e Pilih Panah penunjuk arah yang diinginkan, lalu klik Ok.
e Klik panah penunjuk arah, tarik ke tempat yang cocok di halaman layout.
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Skala Peta

e Ukuran peta dalam hubungannya dengan bumi disebut dengan skala. Biasanya skala dinyatakan dengan
pecahan atau rasio/perbandingan. Sebagai contoh sekala 1: 10.000 artinya jarak satu centimeter di peta
menggambarkan 10.000 centimeter di lapangan.

e Skala sangat penting dicantumkan untuk meliha tingkat ketelitian dan kedetailan objek yang
digaambarkan dalam peta tersebut. Pemilihan skala harus disesuaikan dengan tujuan dan wilayah area
yang digambarkan.

e Skala juga bisa dicantumkan dengan dua cara yaitu: scale text dan scale bar. Scale text berfungsi agar
pengguna peta langsung dapat membaca skala peta dengan cepat. Sedangkan untuk scale bar adalah
sebagai acuan skala peta apabila peta yang telah dicetak mengalami perubahan (diperbesar/diperkecil).

e Scale text

e Klik Insert = Scale Text untuk menambahkan skala teks.

e lalu akan muncul kotak Scale Text Selector.

e Teks skala dapat diubah dengan memilih Properties. Setelah pengguna memilih jenis skala yang
diinginkan, klik Ok.

cale Text Selector A %
Insert | Selection Geop bt ___ -P i
=# DataFrame ' =
{ e Ti ] ' 1:1.000.000
e _ 1¢m =10 km
A Text Certimeters = Kilometers
' Dynamic Text  » 1 centimeter = 10.000 meters
Centimeters = Meters

Meatline... . |
(] Hieathne 1inch = 83.333 feet
g§ Legend... Inches = Fest
Y North Arrow... 1in =16 miles
s aw S | B Inchies ' Mies [F] Scale ta fit page

cale Bar... .
= 1inch = 27.778 yards e —
1:n Scale Text... Inches = Yards & |
' 1 it = 0,22 s | | e
i ageunit= 0o, map units
I=—,I pICturE“I p g Relative Scale p | Save.. l I Reset ]
=] Object... 1in — 02 222 # - Lok | [ coned | _

TN 17

e Menambah Insert Text “Skala” dan “untuk ukuran kertas A4” untuk keterangan Scale text.

Skala

Unfuk ukuEn keras Ad

1:20.000.000

e Scale text adalah dynamis, artinya, jika anda ganti skala peta, Scale Text otomatis berubah untuk
menampilkan peta terkini.

e Scale bar

e Klik Insert = Klik Scale Bar untuk menambahkan scale bar.

e Kotak dialog Scale Bar Selector akan muncul.
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Inzert | Selection Geop e
- o 50 100 200 Miles <
E”J Eﬂtﬂ Frame T T T
L Scale Line 1 i N e
7 Itk IitlE 0 50 100 200 Miles E
o A —t—fr— —t—]
A Text Scale Line 2
D}:namic Text 2 T T T T T i
L] 50 100 200 Miles
D MEEt“ﬂE... Scale Line 3
§§ Legend...
n  Morth Arrow...
:* — [C] Scale to fit page
E= Scale Bar... I
[ Properties... ]
1N Scale Text...
_ e ——(1 [ More Styles o
Z EiCtLIrE... Altemating Scale Bar 2 [ Perm—— ] [ Beact ]
|ﬁ Object... ,L‘n <[ ok ][ cance |
e Skala dapat diedit dengan mengklik Properties. Klik pada Properties untuk pengaturan lanjutan.

e di When resizing... 2 Adjust width dan menentukan Division value (panjangnya segment2) pada 500.
Dengan ini anda bisa memaksa ArcMap untuk membuat panjangnya segment scale bar angka
bulat/tertentu.

e Tentukan Number of division menjadi 3. Ini adalah jumlah segment di dalam skala garis.

e Tentukan Number of subdivision menjadi 2. Ini adalah jumlah sub segment di dalam segment pertama.

e Tentukan Division Units menjadi Kilometers

e Ganti Label menjadi “km”

e Sehingga scale bar memiliki format kilometer, punya 3 bagian dengan panjangnya masing-masing 500km
dan dua subbagian dengan panjangnya 250km.
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Alternating Scale Bar Properties

.

R}

Scale and Units | Numbers and Marks | Formnat | Frame I Size and Position |

Scale

I—
Division value: 1500 k|
Number of divisions: 3=
Number of subdivisions: 2=

|| show one division before zero

When resizing...

| Adjust width

Lnits

Division Units:

[Iﬁlometers

Label Position:

[af‘ber bar

Label:  km

Gap:

3ptl=

OK

| [ Cancel

Keterangan/Legenda

e Agar pengguna peta dapat dengan mudah memahami isi peta, seluruh bagian dalam isi peta harus

dijelaskan dalam legenda atau keterangan. Yang perlu diperhatikan dalam symbologi adalah pemilihan

warna dan symbol, apabila ada aturan bakunya maka harus mengikuti aturan tersebut. Apabila tidak ada

ketentuan yang mengatur maka lakukanlah improvisasi dalam pemberian symbol dan warna, pemberian

keterangan tulisan harus disesuaikan jenis dan ukuran tulisannya.

e Klik Menu Insert = Legend

e Kotak dialog Legend Wizard akan muncul. Kotak ini akan membimbing pengguna melalui 5 tahap dalam

membuat legenda sesuai dengan yang diinginkan.

1. Tahap pertama akan membimbing pengguna untuk memilih data-data yang ingin ditampilkan pada

kotak legenda. Pilih data yang diinginkan untuk ditampilkan di kotak legenda (Sungai dan

p_world_cities saja). Klik Next.
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oot ==

In cert EE'ECti on EEDFI- Choose which layers you wart to include in your legend
B ] Map Layers: Legend kems
=# Data Frame e
F
i ungai e
¢ Tt Title
A Text (1]
] Dynamic Text  » |
[] Meatline.. LS
E e ®
ﬁ Morth Arrow... Set the number of columns in your legend: 1
E=  Scale Bar..
1:n  Scale Teut...
=] Picture... E
[@ Object.. s | <geck [ Mee> ] [ Cancdl |

Tahap kedua membimbing pengguna untuk membuat judul legenda sesuai dengan yang diinginkan
(misalnya “Legenda” atau “Keterangan”).

N

3. Tahap ketiga adalah untuk membuat kotak legenda sesuai yang diinginkan pengguna. Klik menu
drop down border untuk menambah bingkai kotak legenda. Pilih border garis hitam dengan
ketebalan 1. Pilih background warna Yellow dan Gap 5.

R

Legend Title Legend Frame
Legenda| Border
—
Background
Legend Tile font properties Title Justfication E|
e
*You can use this to Drop Shadow
- control the justification e cz
Size: 14 - of the title with the rest
of the legend )|
e ig‘]Aﬁa\ b Gap Bounding
(B] £ u© === 5 0 =
[ <Back J[ Met> | [ cCancel | [ <Back [ bees | [ Concel |

4. Tahap keempat untuk mengedit ukuran dan bentuk lambang yang mewakili setiap data sesuai yang
diinginkan pengguna. Misalnya, lambang untuk data persil dapat diubah ukurannya dan bentuknya
menjadi oval, lingkaran atau kotak.

5. Tahap terakhir membimbing pengguna untuk menentukan jarak antara bagian-bagian yang
disajikan pada legenda peta. Klik Finish setelah menyelesaikan Legend Wizard.
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s e s . ==
You can change the size and shape of the symbol patch used to represent line = e zpnongbetyeen the prt olyourkacnd
and polygon features in your legend. Spacing between
Select one or more legend tems whose patches you want to change. Titke and Legend hems: T | fpis) spacing te
ak . 3 E Legend ttem1 Legend ttem 3
trand i Patch Legend kems: 500 0) | paang tsdrg
width: 2800 (pts)
i S| e B Lol cesoripton = Label desodpton
Height: 1400 | ts) ’ : : B Label desoipior —— Lsbel desodndon
. - Headings and Classes: 500 ipts) Label desaipion Lsbel, o scrtpio
Line e B
| " Ls d temn 2 Legend ltem 4
~ |abels and Descriptions: 500 | pts) || oo n e
- I:IEI lbel desnvipte ] label desoripton
| Patches (vertically): 500 (pts)
Patchesand Labels: 500  fts)
[ <Back |[ MNea> | [ Cancel | [ <Bak |[ Fmsh | [ cancel

6. Untuk Merapikan Text di dalam legenda anda dapat ganti nama layer di TOC

EE=4 Layers
= p_world_cities
Status
® Ibu kota
@ Kota lain
= Sungai

Legenda

Status
® kol
B KoE Gn

o= Sungal

p world cities

5 = layers £
2 of| L[Legenda
Status =l | [KotaBesar | |
@ Ibu kota : Status
@ Kota lain 2 Mok
= Sungai b Ml
2 ~re—r— Sungal

e Anda dapat mengatur Legenda lebih rinci dengan klik kanan di atas legenda dan pilih Properties.

L8 oo

| Legend | ftems | Frame I Size and PosH.ior1|

Spedify Legend Items
Map Layers:

Legend Items:

Change text
@ Allitems () Selected item(s)

Bl
3
Style...

[T Place in new column

Columns:

[Apply to the whole item

-]

e

Map Connection

Only display layers that are checked on in the Table Of Contents
[¥] Add & new item to the legend when a new layer is added to the map
[¥]Reorder the legend items when the map layers are reordered

[[]5cale symbols when a reference scale is set

= bmn B D
Legenda ¥ Zoom Whole Page
5] 7oom to Selected Elements
Kota Besar
Ly L cut Ctrl+X
he @ Copy Ctrl+C
@ Ibukofa| y¢ pelete Delete
= Kota lain n} Convert To Graphics
~"o—— Sunga | I4
0 3250 500 Graphic Operations 3
Order ]
Nudge 3
EBe——" Align »
Distribute r
Rotate or Flip 3
= M S ||'j2 Properties...

[ ok

J |

Cancel ippl'

Menambah Lembaga Pembuat dan Image
Agar peta yang kita buat dapat dipercaya oleh pengguna peta, maka lembaga pembuat harus
dicantumkan. Ini untuk mengakomodasi apabila di kemudian hari ada kritik, masukan atau permintaan
data mendatangi lembaga pembuat peta tersebut.

Selain text anda juga bisa menampilkan Lambang lembaga.
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e Memasukan image ke dalam layout sangat diperlukan untuk keperluan menampilkan logo, foto, atau

tandatangan. Berbagai tipe image sudah didukung oleh ArcMap termasuk JPG.

e Klik menu Insert = Picture
e Carifile Logodi CourseData\Grafik\ dan klik Open

Insert | Selection Geopr
—# Data Frame |
. L oo —
Tile  Title
L Look in: . Grafik
A Text :
=
, i :
D:I[”a mic Tm Recent Places i Z / ._".
. : N
[] Meatline.. [ g e
a— Betion |gizlogo-standard-r  lambang_KM logo ntb Logo_Cooperatio..
i=  Legend.. ey | gbo72 noframe
ﬁ Maorth Errl:l‘w... Lll;ranes
== Scale Bar... A
Computer
tn Scale Text. -
@
Picture... Network
| . o File name: gizlogo-standard-rgb-72_noframe -
. [z Object.. Aesciope:  [Alomes s
an

Sebuah file image akan muncul di tengah-tengah lembar kerja.

e |mage secara default hanya mengelink ke ArcMap Project. Artinya kalau anda pindah atau menghapus
image file, Logo ini tidak akan dapat mengelink lagi dan tidak lagi ditampilkan. Sebab itu direkomendasi
simpang image file ke dalam ArcMap Project file dengan cara

e Klik kanan pada image dan pilih Properties

e Di Picture Properties pilih tab Picture and centangkan Save Image as Part of Document

Picture |Area I Frame I Size and F‘csﬂ.ionl

Source

sar\CourseData\Grafik \gizlogo-standard-rgb-72_noframe. jpg :r_:'.3

I Save Image as Part of Document I

Description
JPEG Image

[ ok ][ Cancel ][ aepty |

e Geser image dan sesuaikan ukuran dengan menggunakan Select Element Tool.

Grid Koordinat
e Tujuan pemberian grid koordinat adalah memudahkan penunjukan dari lokasi objek di atas lembaran
peta. Grid dapat dibuat dengan beberapa satuan tergantung pada sistem koordinat yang diinginkan.
Beberapa pilihan grid yang digunakan adalah:
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- Graticule: adalah membagi peta dalam grid dengan menggunakan koordinat geografis
bisa dalam Derajat - Degree, Minute, Second (DMS) atau Decimal Degree (DD).

- Measured Grid: adalah membangi peta dalam grid dengan menggunakan koordinat
sistem UTM, sehingga yang akan tampil adalah dalam satuan meter.

- Reference Grid: adalah membagi peta dalam grid dengan menggunakan indeks peta
yang telah ada.

e Dari ketiga alternatif grid tersebut diatas, dalam satu peta kita bisa menampilkan lebih dari satu grid
koordinat. Yang perlu diperhatikan juga dalam memberikan grid koordinat ini antara lain: label grid,
garis label, interval, harus disesuaikan dengan keperluan dan keindahan.

e Klik kanan pada data frame, pilih Properties atau ke menu View > Data Frame Properties..

- B
& Add Data.. }., ;
o View | Bookmarks Insert Selec
1 Full Extent
£ | Data View
Focus Data Frame
OO Layout View F
E:E foom Whole Page =g Q ¥ L
#8 Zoom to Selected Elements Graphs .4 i
b cut Ctrl+X Reports 4
B Copy Ctrl+C Scroll Bars I
¥ Delete Delete IZ| Status Bar
@ Rulers
i = Guides
raer 3
e X Mo Grid
Align 5 B ||B«r Data Frame Properties...
Distribute » w Refresh F5
Rotate or Flip 4 Il PauseDrawing F9
TLegenda |Ef Properties... &qp  Pause Labeling
Kota Besar " = atau

e Kotak dialog Data Frame Properties Pilih Tab Grids = New Grid.

| Feature Cache I Annatation Groups | Extent Indicators | Frame | Size and Position
| General I Data Frame: | Coordinate System | llumination | Grids

Reference grids are drawn on top of the data frame in Layout view onk
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e Selanjutnya akan muncul kotak dialog Grids and Graticules Wizard. Kotak dialog Grid and Graticules
Wizard akan membimbing pengguna melewati 4 tahap untuk melengkapi peta dengan garis koordinat
dan koordinatnya. Pada tahap pertama pengguna akan memilih jenis koordinat dan garis koordinat yang
diinginkan. Pilih Graticule dan Klik Next.

Grids and Graticules w_ |2l

Which do you want to create?

arrorw

ol .

00"

B0 0TW AT0TW
L 1
el i -

(@ Graticule: divides map by merdians and parallels

5] () Measured Grid: divides map into a grid of map units

() Reference Grid: divides map into a grid for indexing

Grid name: Graticule

<Back |[ Net> | [ Cancdl |

Catatan: Pilih Graticule jika ingin membuat Grid dengan format derajat (misalnya. Sistem Koordinat Geografis),
Pilih Measured Grid jika ingin membuat Grid dengan format metrik (misalnya UTM).

e Tahap kedua akan membimbing pengguna untuk membuat garis koordinat dan menentukan interval
garis koordinat pada peta. Atur interval koordinat pada 5 derajat (satu derajat kira2 112 km di
kwatulistiwa), bila Anda merasa interval terlalu luas ubah dengan interval yang lebih besar. Klik Next.

e Tahap ketiga adalah untuk mengedit label koordinat dan garis koordinat. Atur ukuran huruf menjadi 8,
dengan mengubah di kotak text style. Atau sesuaikan ukuran huruf sesuai yang Anda inginkan. Klik Next.

A— Appearance Axes

V400N

() Labels only

Style: [V]ai

o ) Tick marks and labels E I b ] E]

Minor division ticks

®) Graticule and labels

Intervals Mumber of ticks per major division: 0

Deg Min  Sec

Place parallels every 5 o 0 latitude

Labeling

rao

Place mendians svery 5 0 0 longtuds

[ <Beck |[ Nea> | [ cancel | [ <Back | Net> | [ Cancel |

e Tahap keempat untuk membuat batas kotak koordinat pada peta. Setelah selesai, klik Finish.
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Graticule Border

(@ Place a simple border at edge of graticule

=

() Place a calibrated border at edge of graticule

| Properties:

Neatline

[ Place a border outside the grid —

Graticule Properties

s
g
o
o
o

o
0
0

() Store as a static graphic that can be edited

@ Store as afixed grid that updates with changes to
" the data frame

<Back [ Fmsh | [ Cancal |

e Hasilnya akan seperti berikut:

LI ==t i "

ia /y ﬁ’ e
(] _ 2
T i
s . W
: nz 5 £
; = & &
i e N
| i - | 4
: i G \v'lﬂ'“l—\li Q’ﬁ:x
za
fras -
E P gp‘- o ,E?T
EES A
N R
e e = m’“{
L i e T VL FET
Kota Basar Untuk wiuran kerfas Ad
: :::T- 120-000000 Sumber Dada: ESRI Data 2008
o 0 280 500 1000 1500 .
—m Tumgal R Dioust oleic GIE /P O swald {201 Z)

e Mengatur Grid (Huruf, Garis, Warna,Interval, ...) lebih lanjut dengan Pilih View = Data Frame
Properties = Tab Grids

e Pilih Gridnya (Graticule) dan klik Properties...

e Di Reference System Properties Pilih Tab Labels dan ganti Label orientation — Vertical Labels untuk left
dan right seperti berikut:
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| Feature Cache | Annctation Groups | Bdent Indicators I Frame | Size and F'&?silion | n I s Labels| Labels |L1n&s |Hatching I lntenrals|
| General I Data Frame I Coordinate System | llurmination ‘ Grids
Label Axes
Reference grids are drawn on top of the data frame in Layout view only. i i . i
Top Left Bottom Right
Label Style
Format: [Degrees Minutes Seconds v]
Properties.. =
Fort: |0 Aval -
Coi To Graphics
e Tp Size: 6 b B I U
Color: E Label Offsat: 6 . pts
Additional Properties...
Label Orientation
Vettical Labels:
[ Top Left [ Bottom
e

Mengatur Tampilan Data Frame

e Jika anda ingin mengganti background color pada Data Frame (misalnya untuk membuat Laut warna
biru) anda harus buka Data Frame Properties dan Pilih Tab Frame
e Pilih warna Light Blue untuk Background.
e Dengan Color Selector anda bisa menentukan warna lebih lanjut.
i Data Frame Properties M[‘
| Genel | DataFrame | Coordinate System | lumination | Grds |
| Feature Cache | Annotation Groups | Extent | Frame | Size and Postion |
Border
18 o (IS
Gap X 0=ipts Y: 0% pts  Rounding: o=y
Background
gl o
Gap X 0= pts Y 02| pts  Rounding: C S
Drop Shadow ,iu
e Rl
B FEERECEEEEEEN
; i EEEEEEEEEEEN :
15 13 BN NN W W W W | Color Selector :Lg
HEEEECODEENNEN N coor [popertes HSV._ ~ M
[] Draft mode - just show name | § § I=jimimispey 4§ § ° |—L_CMYK \
EEEEDEEE e, .
EEEEEEEEEEEE[E =
l More Colors... b
v o 100 %
Ji [————
0K Cancel
[ Lo

Penjelasan Sistem Proyeksi

tentang sistem poyeksi yang digunakan dalam membuat peta tersebut.

dengan

Klik kanan pada Data Frame dan pilih Properties dan Pilih Tab Coordinate System

Keterangan lain yang perlu disampaikan dalam peta yang dibuat adalah adanya penjelasan singkat

Anda seharusnya menulis sifat proyeksi Data Frame. Anda bisa memeriksa Proyeksi Data Frame anda
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Feature Cache | Pnnotation Groups | Bdent Indicators | Frame | Size and Position
General | DataFame | Coordnate System
Current coordinate system:

GCS_WG5_1984 - Clear
Datum; D_WG5_1984

|

: G
Select a coordinate system:
EHE Favorites Modify...
= USA_Contiguous_Albers_Equal_Area_Conic

St WGS5 1984 UTM Zone 505
(-] Predefined
@El Layers
] <eustom>

£l

Mew

|  AddTo Favorites

Remove From Favorites
Corce | [ oot

e Di Current coordinate system ditulis proyeksi data frame ini. Dalam contoh ini, data frame kita
diproyeksikan dengan GCS_WGS_1984, Datum D_WGS_1984, artinya Sistem Koordinat Geografis,
Datum WGS 1984.

e Insert Text Menu Insert = Text dan tulis seperti di gambar di bawahnya.

Text | Size and Postion

Teat:

<bol=<ITA>Grd</| TA></boal= &
Sistem Koordinat Geografis

<bol=<|TA>Proyeksi dan Datum</1TAz</bol>
Sistem Koordinat Geografis, WGS 1984|

4

Fort:  Aval 8.00 = = =
Angle: 0.00 :_ Character Spacing: 0.00 :
Leading: 000 | f )
Grid
Sistem Koordinat Geografis
T FProyeksi dan Datum
Lo Jlcms || i Sistemn Koordinat Geografis, WGS 1984

Peta Situasi / Peta Index
e Peta yang dibuat harus diketahui dari bagian bumi sebelah mana yang dipetakan. Peta situasi ini dibuat
disesuiakan dengan tujuannya. Biasanya peta situasi dibuat dengan skala yang lebih kecil. Sebagai
contoh: apabila areanya satu kabupaten, maka peta situasinya meliputi satu provinsi.
e Untuk Peta Situasi kita harus membuat Dataframe baru yang akan diisi dengan data untuk peta situasi.
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¢ Insert Data Frame berguna apabila pengguna ingin menampilkan lebih dari satu data frame / peta di
satu halaman kertas, misalnya untuk insert peta atau untuk dua peta yg menampilkan situasi satu lokasi
saat/tahun berbeda. Langkah — langkahnya sebagai berikut :

e Tambahkan data frame terlebih dahulu, dengan mengklik Insert = Data Frame.

st sindons st i - v

File Edit Wiew Bookmarks | Insert | Selection Geoprocessing Customize Windows Help

D @& ¥ B @ x = Duafome oo “EE gaa
Ite  Title DRER@FNe ~ BRM
Table Of Contents EEA ™ T A e L e L
TRl B icText  »
BCE 3 Pynamic Peta Ad
S & Layers I:l Meatline... =z arzae s e
i S b -
E [ Kota Besar i=  Legend.. j g FT;_I ﬁ;ﬁl g
Status + 1 | 'LB i !
n  Morth Arrow... 1 | T i
@ Ibu kota R | | xﬁ
@ Kotalain Rl A Tt | ?‘\_L,. '"' = L'
= M Sungai tn  Scale Text... || *# | New Data Frame | o:
= =l Picture.. | thi‘ R\gz 1 : v’#
= @ e PR | ISl =
[ <all other values> | || L : Bt _horems ® L4 CECKLF 7
] P kS -]
CNTRY_MAME 1 L
[1Indonesia -:r?! E i"\\p-..-.-m b L""iﬂ“ﬂ
| 1y
spmEE || - o .
. f B

e Ganti nama New Data Frame menjadi Peta situasi (di TOC).

e Mengatur posisi dan ukuran Data Frame “Peta situasi”. Pilih Data Frame tersebut dan geser.

e Pada TOC drag and drop layer Negara dari Layers ke Peta Situasi.

e Menonaktifkan Labeling pada Layer Negara di Data Frame Peta Situasi dan zoom out supaya bisa
melihat South East Asia.

e Ganti Symbology untuk Indonesia dan all other values (outline width = 0)

e Setelah itu, pada halaman layout akan tampil peta dan peta inset.

Tutorial Arcgis10 Tingkat Dasar GIZ-DeCGG | Bappeda Province NTB



File Edit View Bookmarks Insert Selection Geoprocessing Custornize Windows Help

DB@S %GR x| b QMO SEIN@ Al =
DAFTE EBER ETs - BRME 5.

Table Of Contents "X L dn 20 B0 20 08I 8 B 00

g S8 B =

g & Layers F_’fftaﬂdministrasilndonesia 2? z

= Kota Besar

7
&
]
R

L e

Status = i é_Li . [~ .ﬁ fué’u}g ik o . | E
@ Ibu kota 3 ol e \t%&\ c/‘4"'3,_\’ S | s’%"‘é**’; b

|6

@ Kotalain i [y ; i ;
- TR 7 y i ;
- E S gy {\:JNJ L : :
=] MNegara F £ n% i % ..—!,H_u..... e | =
] <all ather values> ] \ T
= [ EE
CNTRY MAME | |[= ; \ ﬁg L"“"'\
[1Indonesia E : N \rﬁ&: -
i i:?}
=) = Peta Situasi i
= Negara 5 N
<all other values>] ||~ k
CMNTRY_MAME | :m. ---------------
L Jindonesial = i 8 RE
] : :’: 1:20.000.000
1 | ] e e

Catatan: Data Frame merupakan wadah untuk data peta. Dengan mengedit Propertiesnya anda bisa
mengatur masing-masing data frame (sistem koordinat, grid, ...). Untuk tambah data dataframe harus
diaktifkan (klik kanan di atas nama data frame dan pilih “Activate”. Nama Data Frame yangg aktif
pupnya style yangg tebal (bold).

Kalau anda menambah Scale Text, Legend dll. lewat Insert, ArcMap inster item terkait/linked dengan
Data Frame yang aktif saat Insert Element.

Untuk peta situasi yang telah dibuat, juga bisa ditambahkan grid koordinat dengan caranya yang sudah
dijelaskan di atas.

Menambahkan Extent Rectangles

Extent Rectangles merupakan frame/garis kotak di dalam peta situasi yg menunjukan luasnya data
frame utama.

Klick Data Frame Properties pada peta situasi dan pilih tab “Extend Indicator”.

Di kotak Other data frames anda bisa lihat semua data frame di proyek ini kecuali dataframe yg anda
sekarang dibuka diproperties.

Pilih Dataframe yang anda ingin tampilkan luasnya di peta situasi dan Klick panah kanan sehingga
Dataframe yang dipilih geser ke “Show extend rectangle for these data frames:

Menentukan Style untuk extend Rectangle di Frame. Warna Merah, Border width 2 point.
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e | -
| General I Data Frame | Coordinate System llumination Grids
[ ot Cache | At Groups | Exens hcatar

Yfou can add one or more extent indicators to this data frame. Each indicator Extent Indicator Frame me_ M
shows the extent of the data in one of the other data frames and automatically
tes if the extent ch =
updates if the extent changes. m‘
Show extent indicator for
Other data frames: these dats frames: Border
] Colar:
) Gap X il : pts Y: D: pts  Rounding:
Background
= 1 | E
= B Colon |
v
Options - Layers Gap = O pts v 0 ptz  Rounding %
[T Use simple extent
Drop Shadow
[T 5how Leader .
“olo
Leader Symbal... E], e
Offset 3| 152 pts v | 152 | s Rounding,
["] Draft mode - just show name
ok ) e ][ oo ]
e Hasilnya ada seperti di bawah:
ove sore 100w s were
Bl S
A ®
-
Phjifigfrin g s Dayao
. L]
£

(1 - N - - &
L S & :3%7)/\ Jayapura
Mengatur Obyek

e Pada gambar di atas, Text, Scale Bar, Scale Text, Lambang dIl. masih belum tertata dengan rapi. Kita
perlu melakukan hal-hal sebagai berikut:
- Meratakan agar Lambang2 sejajar secara horizontal
- Skala, Text Skala dan Scale Bar sejejar vertical
e Memilih obyek untuk pengaturan dilakukan sebagai berikut:
e Pilih yang tiga lambang dengan menggunakan Select Element
e Pemilihan dapat dilakukan dengan menggunakan tombol CTRL ditambah dengan Klik pada masing-
masing obyek. Alternatif kedua memilih obyek adalah dengan membuat ‘kotak’ yang meliputi seluruh
obyek yang akan dipilih dengan menggunakan Select Element.
e Saat Element2 Lambang terpilih, Right Click di salah satu obyek tersebut
e Pilih Align

e Pilih Align Vertical Center
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U I8 Group
j} ‘j Graphic Operations 3
EEH:IWS'“” alial i g
"jl‘ e Mudge 3
=gl e ‘ Align r | =i Align to Margins
Distribute ' IB  Align Left
Rotate or Flip Y | & Align Center
Properties... 5| Align Right
: igf  Align Top
| o  Align Vertical Center
it Align Bottom

e Buat align vertical dengan cara yang sama (pilih Align Center = ) kepada Scale text, Scale Bar dan
keterangan Scale Text.
Order 3 Austr:
| = | < pe i f"r
forE AL A AL Mudge P oebos LI
T T T ' Align > | S Align to Margins
Untuk ukuran kertas Ad: T S e
:90.000.000 o oo JER -
R e | e &l  Align Right
0 250 500 1.000 1.500 | SEEEEEEEErES iT| Align Top
I I ki ibuat clzh: GIZ/ ; _
R KM DeeseenORIR gy verical Conter |
— il Align Bottom F
e Kemudian group (kelompokkan) Element2 tersebut agar lebih mudah mengesernya.
e Pilih Element yang anda ingin kelompokkan dan klik kanan satu element

e  Pilih Group i

=

e —

Bandung

rsng

iy

Lut

Copy
Delete

Ltri+ X
Cirl+C
Delete

Convert Te Graphics

Group

7 E| 2 X o

Graphic Operations

Order
MNudge
Align
Distribute

kuran kertas A4:

Rotate or Flip
[ Properties..

Untuk ukuran kertas A4

~1:20.000.000

250 500 1.000 1.500 !

RITT,

Dibust oleh: GIZ/
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Sebelum memberi label, kita harus sudah mengetahui terlebih dahulu data atribut apa saja yang ada
dari layer yang akan kita beri label.

Ada Toolbar Graphics yang menyediakan banyak tools untuk menatur Element -element Peta.

L5 !

Th % &

S B & Smag o HE D248

Penggaris (Rulers) dan Guidelines(garis bantuan)

View

Alat ini digunakan untuk menempatkan element peta di dalam layout yang dibuat supaya lebih rapi dan

indah

Untuk menampilkan ruler, aktifkan tool tersebut pada menu View =>Rulers

Dari Rulers anda bisa tarik dan membuat Guidelines yang digunakan untuk snapping element layout

peta supaya align lebih rapi.

Bookmarks  Insert  Seled

Data View
Layout View
Graphs
Reports
Scroll Bars

Status Bar

e

Rulers

0 & BEFEE ]

-

E

Guides

Grid

Data Frame Properties...
Refresh F5
Pause Drawing Fa

Pause Labeling

EL{L Ll -A.A_I_-!._J.J..A..L{!u_a_.._l.%_a.- | -...;..;J.?'..J_J_

g:

-_ gl 'm"'..'\'!':. 'H'\:'E'E.
l"‘-- E " Y? 1 i i
= E Yt

] T ilgind

1 g

1 iy

Untuk mengaktifkan/menonaktifkan snap kepada guides (garis bantuan) klik kanan di suatu tempat
kosong di Layout View dan pilih Guides = Snap to Guides

Insert Frame / Neatline

18

16

|4

[ PO [rnmgaman [Zoe s, B 14

Zoom Whole Page
Go Back To Extent

e

Peta Ad
Page and Print Setup... i penoE
TR UEy
Toggle Draft Mode Tl
Cut Cirl+X Py
Copy Ctrl+C
Paste Ctrl+V
Delete Delete

Eanaar Sen Bl

Mslaysis)
Select All Elements Al
Unselect All Elements Sigapare 3

s . e

Zoom to Selected Elements i ForiEnsk

Rulers » ‘;4) R
Guides v [ Guides
an M

Grid »
Margins 3

RO x@m+ 00

Snap to Guides ‘

ArcMap Options... @";\“‘ng

Peta seringkali lebih indah kalau mempunyai rangka/frame.
Klik Insert 2 Neatline untuk menambah satu Frame pada peta kita.

Di Dialog neatline anda bisa mengatur Frame.
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e Pilih Place inside margins (untuk mengambar frame di printer margin)

e Pilih Gap = 3, dan rounding = 0 supaya ada frame rectangle yang sedikit lebih kecil daripada printer

margin.
e Pilih Border width 1 point warna hitam

nsert | Selection_ Geopr  Neatine B 222 0200
=i Data Frame Placement Border
Tie  Title Place around selected elementis) | ‘ ]
A Tes () Place around all elemants =
) &) e :
Dynamic Text N @ Place inside mangins B
| D Neatline... Create separate neatline element ]
iZ  Legend... r Group neatline with element|s) -
% Morth Arrow... Drop Shadow
i Gap: Rounding: -
== Scale Bar... i ] L"? 235 . :|
un Scale Text... E]
El Picture...
: OK Cancel
@ Object... [ J [ L ]
m
e Sesudah mengatur Element-element, peta kita selesai.
Peta Administrasi Indonesia 2012
: Mysiidr g R I EERE R |
g 7 E
TE \I\:\ . :a Phiiigpin ¢ s Dayec
! e
H ?\___\_\ gon Bandar Seri Begawsan = =
1 = G o
Sipgapore ing Manado
E Padang E ;gb\nuone ] i Ve KL\ TS El
3 N B
t\)g\\\z ® o Opp & @ -;?;\ Jayapura
K me;? & % AL T\
g 5g 3 gl
£ = e aiss 5|
\'5\ an”g /\p * W @f Papug Ng¢w|Guinea
% e % . A F ;
bl L e
P P AR VO i & ;
z f@) gl
. 2 4 . a1t
os |s A
A e Australia ri::é
LEQEI‘I da Ska| a . ] GIZ vtgb;:\::l?{.zmz;
Kota Besar Untuk ukuran kertas A4 Sistem ch;:\:t Geografis H
& s 1:20.000.000 Proyehsidan Damm
& Kot i Sistem Koordinat Geografis, WGS 1984 3 A i
Sh=nis %?&?ﬂ D SamT - i g IZ
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Menyimpan Peta

Ll
e  Untuk menyimpan peta, klik menu File>Save As. Atau dengan meng-klik ikon . Peta dapat disimpan

dalam ekstensi mxd dan mxt. Ekstensi mxd adalah untuk menyimpan peta dalam bentuk dokumen
project, sedangkan ekstensi mxt untuk menyimpan peta dalam bentuk template.

Ekspor Peta

¢ Klik menu File = Export Map. Peta dapat diekspor ke berbagai macam format, seperti PDF, JPEG, TIFF,
dan lain-lain. Untuk bagi peta dan mengeprint di computer lain, format yang paling cocok adalah PDF.

Untuk masuk peta ke dalam Power Point Presentasi, lebih bagus pilih Jpeg atau tiff. Dalam contoh ini
pilih “Save as type” format PDF.

e Di Options-Tab “General” pilih resolution dan image output quality (Resample Ratio) yang cocok. Seting
ini merupakan kompromi antara kualitas peta dan ukuran file (file size). Di latihan in anda ingin kwalitas

yang bagus. Pilih 300dpi dan Resample Ratio “best”.

e Di Options Klik Tab “Format”

e Centang “Convert Marker Symbols to Polygons” dan “Embed all document fonts” supaya simbol-
simbol yang digunakan di petanya digambar dengan benar di computer lain.

e Klick Save untuk expor peta ke format PDF.

Qe s Qe e

Savein: [ Desktop - 02 E & Savein: [ Deskiop - 02 E &
i == = i == =
ik ibraries [ ik ibraries [
= sl System Falder = sl System Falder
Recent Places i = Recent Places i =
! Patrick E ! Patrick E
J"ﬁ? System Folder J:‘? System Folder
Desktop 9 Desktop 9
.| e '~" Computer .| e '~" Computer
| U System Folder | U System Folder
Libraries F Libraries F
j“. Network j“. Network
A ; System Folder A ; System Falder
7. ==
Computer ArcGIS_101 Computer ArcGIS_101
-, r File folder -, r File folder
| @ | @
N AemfIC Codibme me ACKA I 1 N AemfIC Codime ne ACKA I 1
File name: Bab04_Petalndonesia_Patrick - Save File name: [Bab04_Petalndonesia_Patrick pdf - Save
Save astype PDF - [ Cancel | Save astype [PDF vl [ Cancel |
7 Options 7 Options
General | Fomat | Pages | Advanced | General Fomat | Pages | Advanced |
Resolution: 300 = dpi Destination Colorspace:  RGB -
| Output Image Quality (Resample Ratio) [7] Compress Vector Graphics
0 Image Compression: Adaptive -
Fast Normal Best
JPEG Qualty:  Low - {1 Max
Ratio: Hipl
Picture: Symbal: Rasterize layers with bitmap markersfils
[¥] Convert Marker Symbols to Polygons
[¥] Embed Al Document Fortts
[F] Clip Output to Graphics Extent [F] Clip Output to Graphics Extent
Mencetak Peta

e Pilih Menu File = Print

e Kotak Print akan muncul. Setup cetak dapat disesuaikan dengan meng-klik Setup.

e Maka akan tampil kotak dialog Print untuk memilih printer, ukuran kertas dan kualitas cetakan.

e Print layout sama seperti melakukan print dokumen di MS Word. Yang patut diperhatikan adalah
ukuran kertas. Biasanya membuat layout di ArcMap memiliki ukuran besar misalnya A2, Al, atau
bahkan AO. Hanya untuk kepentingan praktek saja pada bab ini membuat peta ukuran A4,

e Printer Engine dibiarkan saja default Windows Printer

e Kualitas Image bisa diatur. Untuk hasil paling bagus pilih Best, untuk print test dibiarkan Normal saja.
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Printer

Name: EPSON TX121 Series ||
Status: Offline

Type: EPSON TX121 Series

Where: USB002

Comments:

+ [ Properties... | [__] printer Paper(e) that wil be printd

Printer Engine: Windows Printer

Cutput Image Quality (Resample Ratio) |:| Map Page (Page Layout)
————— E Sample Map Elements

Fast Normal Best

Ratio: L=l 2

Tiling

Tile Map to Printer Paper

Al 1 tilels)

Ties  from: E ko E

Scale Map to fit Printer Paper

Mumber of Copies: 1: E|

[T print to File E

e Untuk mengeksekusi perintah print, Klik OK.
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